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Introduction 

IBackup Professional is a secure, efficient, reliable, cost effective and easy-to-use Internet based 
backup solution, with an emphasis on security and data retention. It employs to-and-fro encryption 
(256-bit AES encryption on storage and 128-bit SSL encryption during transmission of data), 
thereby ensuring data security. The application allows you to retain up to 30 versions of data. It 
has several advanced and powerful features, coupled with a user-friendly interface. 

IBackup Professional can backup and restore your MS Exchange Server and MS SQL Server 
databases to your IBackup Professional account without interrupting the already running MS 
Exchange Server/SQL Server services. 

IBackup Professional also allows you to backup individual mailboxes on the MS Exchange Store 
to your IBackup Professional account. The application backs up the contents of the selected 
mailboxes to a Personal Folder (.PST) file that can be accessed using Microsoft Outlook, at any 
point in time. 
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Features 

General Features 

� IBackup Professional lays emphasis on security of data. During backup, files are 
encrypted using 256-bit AES encryption before being transmitted to our data centers, 
using an Encryption Password (user-defined password) known only to the user. Even 
IBackup Professional personnel do not have access to your data, thereby ensuring 
maximum data security. 

You need to enter the Encryption Password while downloading the IBackup Professional 
application and store it carefully at a safe place for future use. 

� IBackup Professional supports versioning of both backed up files and individual files. 
Thus, you can restore a set of backed up versions and/or up to 30 prior versions of a 
single file. 

� IBackup Professional has a user-friendly interface, much like the Microsoft Windows 
explorer, making it easy to select files and folders for backup and restore. 

� IBackup Professional facilitates effective network bandwidth usage by compressing data 
files during transmission. 

� IBackup Professional supports incremental backup. Only the modified portion of a file that 
was backed up previously is stored thereby making backups more efficient. 

� Each backup creates a new Backupset, identified by the corresponding backup date and 
time. 

� Data backed up using IBackup Professional can only be accessed and restored through 
IBackup Professional application interface or web interface. This feature helps preserve 
and maintain integrity of data. 

� The IBackup Professional application/agent can be setup to perform backups/restores 
from behind HTTP / SOCKS proxy servers. 

� The Schedule Backup wizard on IBackup Professional has a provision for email and/or 
desktop notification – details on the status of the user’s scheduled backup jobs. 

� The Search option helps you locate files in your IBackup Professional account, based on 
the file name or type. 

� IBackup Professional lets you view the log files of backup, restore, scheduled backup and 
the details of files and folders that deleted from your account from any computer, using the 
Internet browser (Managed Backup Log Information). 
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Advanced Features 

� IBackup Professional supports backup of mapped drives even when your computer is in 
the logged off state. 

� IBackup Professional offers efficient storage computation since the storage space is 
calculated only for the latest version of a file and not based on the historical versions. 

� IBackup Professional has the ability to automatically backup most commonly used user 
data and application data types. 

� IBackup Professional provides an easy, fast and reliable way to backup and restore MS 
SQL Server database files.  

� IBackup Professional provides an easy, fast and reliable way to backup and restore MS 
Exchange Server database files.  
  

Other Advanced Features 

� IBackup Professional maintains the image of the data backed up, as it existed at the time 
of backup. This allows for accurate restore of the Backupset (Show/Hide Snapshot). 

� You can view the status of the scheduled backup jobs and the corresponding log files, 
using the tray icon. 

� Bandwidth throttle feature lets you adjust the bandwidth being used by the application, 
thus allowing access to the Internet to use other applications. 

� IBackup Professional supports two-way Sync from the user’s computer (My Computer) to 
the user’s IBackup Professional account and vice-versa. 

� IBackup Professional can backup open files using the Open file Backup feature. This 
feature is available for Windows Vista, Windows XP and Windows 2003 Server. 
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Downloading and Installing IBackup Professional 

Click http://www.ibackup.com/ibackup-professional/online-backup-download.htm  to download the 
application. Once it is complete, you can see the IBackup Professional setup (the executable file 
that launches the IBackup Professional installer program). 

Follow the steps given below to install IBackup Professional: 

1. Double-click the IBackup Professional Setup Icon > a welcome window appears. 

2. Click the Next button if you would like to proceed. Else, click the Cancel button. 

3. On the License Agreement screen, select the ‘I accept the agreement’ option if you wish to 
fully comply with the IBackup Professional terms and conditions and click the Next button. 

4. Select the destination where you wish to install the application and click the Next button. 

5. A dialog box appears - which indicates the installation status of the IBackup Professional 
application. 

6. Enter the encryption password if you are installing the application, on your computer, for 
the first time. 

You must remember the encryption password, as it is needed while installing the IBackup 
Professional application and to access the encrypted file(s). We strongly recommend that you 
archive this encryption password at a safe place. You cannot retrieve files from your IBackup 
Professional account without this encryption password that you had entered the first time while 
setting up IBackup Professional agent for your computer. 

7. Click the Finish button to close the Wizard. A login window appears as shown below. 
Enter the appropriate username and password. On login, the IBackup Professional main 
window appears.  
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Menu Bar Options 
IBackup Professional menu bar has the following options: 

• File 

• Backup-Restore 

• Tools 

• Activity Log 

• Help 

File 

The File menu has options that let you connect and disconnect from your IBackup Professional 
account and also exit from the IBackup Professional application. 

File menu has the following options: 

• Connect 

• Disconnect 

• Exit 
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Connect 

The Connect submenu option lets you connect (log on) to the IBackup Professional application. 
This option is enabled only if you are disconnected from the application. 

How to Connect 

File menu > Connect > a Login window appears > enter the User Name and Password > click the 
Login button. You are logged into the IBackup Professional application, if you enter valid 
authentication details. 

The shortcut key for Connect is SHIFT+F1. 

Disconnect 

The Disconnect submenu option lets you disconnect from your IBackup Professional account. On 
doing so, the details displayed on the Restore tab would be cleared. This option is enabled once 
you are connected to the application. 

How to Disconnect 

File menu > Disconnect > you will be disconnected (logged off) > the files and folders present on 
the Restore tab are cleared. 

The shortcut key for Disconnect is SHIFT+F2. 

Exit 

The Exit submenu option lets you close the IBackup Professional application without logging you 
off. 

Note 

Previously scheduled backup operation continues even after you exit the IBackup Professional 
application. 

  Page 8 of 59 



 

Backup-Restore Menu 

Automatic Selection Wizard 

The Automatic Selection Wizard guides you through a simple step-by-step approach to backup 
files and folders immediately or schedule it for a future date and time. 

By default, the wizard selects a list of most commonly used user data and application data files 
that need backup. You can select or clear the selection, depending on your backup needs. 

To open the Automatic Selection screen, click the Backup-Restore menu option > select Automatic 
Selection, the following window appears. 

 

After selecting the required user data and application data file types, click the Apply button. 
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Update the contents of the backupset in the Automatic Selection Wizard 

To update the contents of the backupset in Automatic Selection Wizard, double-click the 
Automatic Selection entry available under the Contents of my Backupset header, as shown below. 

 

The Automatic Selection window appears. Now, modify the selections based on your backup 
needs. 
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SQL Server 

The SQL Server menu consists of the following options: 

• SQL Server Backup 

• SQL Server Restore 

SQL Server Backup 

The SQL Server Backup option lets you backup MS SQL Server database files (.dmp) to your 
IBackup Professional account. 

To access the SQL Server Backup option, click the Backup-Restore menu > SQL Server > select 
SQL Server Backup. 

 

Features 

� Validating user information using Windows NT or MS SQL Server authentication 

� Lists database according to the user’s access permissions 

� Reports progress of the ongoing Backup process 

� Generates automatic logs for the backup process status 
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SQL Server Login Information 

IBackup Professional provides two modes of MS SQL Server authentication: 

• Window Authentication Mode 

• SQL Server Authentication 

 

Windows Authentication Mode 

When you connect through a Microsoft Windows® user account, MS SQL Server validates the 
account name and password using information present on the Windows operating system. 
 
 MS SQL Server authentication 

The MS SQL Server authentication lets you access the MS SQL Server using the information given 
in the MS SQL Server. 

Note 

If you try to connect to the MS SQL Server without giving any login name, then the MS SQL 
Server considers the information that exists on the user’s Windows operating system for the MS 
SQL Server authentication. 
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Backup database files 

Select one or more database files from the list displayed in the SQL Server Database screen. 

 

Click the Browse button to select a drive/folder. The IBSQLTEMP is the default folder. Ensure that 
the folder has sufficient free space to hold the database files. 

For example, if you select D Drive as your local backup path, then the SQL destination path is 
D:\IBSQLTEMP.  

Click the Next button to access the Scheduler Wizard window. Here, schedule the backup for a 
future date and time or perform an immediate backup of the files. For details, refer to Schedule 
Backup. 
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SQL Server Restore 

The SQL Server Restore wizard lets you restore your database backup files (.dmp) from your 
IBackup Professional account to your MS SQL Server' 

To access the SQL Server Restore option, click the Backup-Restore menu item: > SQL Server > 
select SQL Server Restore. 

 

IBackup Professional provides two methods of restoring the database backup file (.dmp) into the 
MS SQL Server. 

Option 1: Restore the SQL Server database backup file from your IBackup Professional account 
to your SQL Server database. 

Option 2: Restore the SQL Server database backup file from your local computer to your SQL 
Server database. 
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Using Option 1 

1. Select the first option Restore SQL Server database backup file (.dmp) from your IBackup 
Professional account to your MS SQL Server database on the Welcome to SQL Restore 
Wizard and click the Next button. 

2. On the SQL Server Login dialog, after selecting the relevant authentication mode > enter 
your user name and password > click the Login button. 

3. Select the database backup file (.dmp) from your IBackup Professional account contents 
> click the Next button. 

 

4. On the Restore destination dialog, select Restore to the following directory option and 
Browse to choose the destination directory on your local computer > click the OK button. 
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5. A Restore database backup file window appears > click the SQL Restore button to begin 
the restore process. 

 

6. A message indicating that the Restore operation will overwrite the existing database in the 
SQL Server with Yes and No option appears. Click the Yes button to proceed. 

Using Option 2 

1. Select the second option Restore SQL Server database backup file (.dmp) from your local 
computer to your SQL Server database in the Welcome to SQL Restore wizard. 

2. Enter the relevant authentication information. For details, refer to SQL Server Login 
Information. 

3. Browse to select the database backup file (.dmp) from your local computer. The location 
should be the same where the database backup file was restored earlier. 

4. Click the SQL Restore button in the Restore database backup file window to begin the 
restore process. 

5. A message indicating that the Restore operation will overwrite the existing database in the 
SQL Server with Yes and No option appears. Click the Yes button to proceed. 

6. On completion of restore, a message indicating the same appears. A Completed status is 
reflected in the Status field. 
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MS Exchange Server 

The MS Exchange Server menu consists of the following options: 

• MS Exchange Server Backup 

• MS Exchange Server Restore 

• MS Exchange Server Brick-Level Mailbox Backup 

• MS Exchange Server Brick-Level Mailbox Restore 

MS Exchange Server Backup 

The Exchange Server Backup wizard lets you backup the MS Exchange Server database to your 
IBackup Professional account. 

1. To access the MS Exchange Server option, click the Backup-Restore menu > Exchange 
Server > select Exchange Server Backup. 

 

  Page 17 of 59 



 

2. In the Exchange Server Backup window, select the Public Folder Store/Mailbox Stores 
that you would like to backup to your IBackup Professional account. 

 

3. Browse to select a temporary location on your local computer where the MS Exchange 
Server backup resources would be stored > click the Next button. 

Ensure that the selected temporary location has sufficient free space to hold the MS 
Exchange Server backup resources. 

You cannot select the temporary location if you are performing MS Exchange Server 
backup from a remote location. 

4. In the Scheduler Wizard screen, schedule the backup for a future date and time or perform 
an immediate backup of files. For details, refer to Schedule Backup. 
 

Important 

On successful backup, the backed up MS Exchange Server resources are stored in the folder 
IBACKUPPROFEXCHBACKUPSET. 

Do not update/delete files from this folder, as it would interrupt the Exchange Server backup 
operation. 

Note 

Do not use the IBACKUPPROFEXCHBACKUPSET as a destination folder for any other backup or 
restore operation. 

At any point in time, you can maintain only one backup job “IBEXCHANGEBACKUPset.” 
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MS Exchange Server Restore 

The IBackup Professional Exchange Server Restore wizard lets you restore your MS Exchange 
Server Public Folder store and the Mailbox stores (Storage Groups/Databases) from your IBackup 
Professional account back to the MS Exchange Server. 

We recommend that a technically qualified person perform the MS Exchange Server restore 
operation. 

Perform these mandatory steps before initiating the MS Exchange Server Restore operation. 

I. Start the MS Exchange System Manager from Start > Programs > Microsoft Exchange > 
System Manager. 

II. Right-click the Public Folder store/Mailbox stores that needs to be restored and choose 
the Dismount Store option. 

III. Right-click the Public Folder store/Mailbox stores and choose the Properties option. 

IV. On the Properties screen, select the Database tab and then enable the option, ‘This 
database can be overwritten by a restore’. 

Now, click the Apply button followed by the OK button to confirm the operation. Perform the steps 
three and four (III and IV) for all the databases that need to be restored. 

Note 

Once the above steps are performed, close the MS Exchange System Manager before initiating 
the restore operation. For every restore operation, the existing databases on the MS Exchange 
Server are overwritten. 

We recommend that you to take offline backup of the MS Exchange Server databases that you 
wish to restore, before initiating the restore operation. 
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Restoring MS Exchange Server 

Once the database is dismounted, login to the IBackup Professional application. 

To access the Exchange Server Restore option, click the Backup-Restore menu > Exchange 
Server > select Exchange Server Restore. 

 

IBackup Professional provides two methods to restore the Public Folder store and the Mailbox 
stores (Storage Groups/Databases) to your MS Exchange Server. 

Option 1: Restore the MS Exchange Server databases backup from your IBackup Professional 
account to the MS Exchange Server. 

Option 2: Restore the MS Exchange Server databases backup from your local computer to the 
MS Exchange Server. 

Using Option 1 

Restore MS Exchange Server databases backup from your IBackup Professional account to 
the MS Exchange Server 

1. Select the first option and click the Next button. 

2. On the Exchange Server Restore screen that appears, select the folder 
IBackupProfExchBackupset from your IBackup Professional account. 

To restore even a single Storage Group or a database, you need to restore the complete 
Exchange Backup folder (IBackupProfExchBackupset) from your IBackup Professional 
account. 

3. Select the database backed up files from your IBackup Professional account contents > 
click the Next button. 

4. On the Restore destination dialog, select Restore to the following directory option and 
Browse to choose the destination directory on your local computer > click the OK button. 
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5. On the Exchange Server Restore screen that appears, click the Browse button and select 
the temporary location where the MS Exchange Server related files are to be stored. 

 

6. Select the database and click the Restore button to begin the restore operation. During 
restore, the files are restored from your local computer to the MS Exchange Server. 

Important: 

Do not interrupt the restore operation. 

7. On successful completion of the restore operation, the restored databases (Public Folder 
store/Mailbox stores) are displayed in the MS Exchange System Manager. 
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Using Option 2 

Restore MS Exchange Server databases backup from your local computer to the MS 
Exchange Server 

1. Select the second option and click the Next button. 

2. On the Exchange Server Restore screen that appears, click the Browse button and select 
the IBackupProfExchBackupset folder on the local computer (the location should be the 
same where it was restored earlier from the IBackup Professional account). 

3. Click the Browse button and select the temporary location. 

 

4. Select the database and click the Restore button to begin the MS Exchange Server 
restore operation. 

5. On completion of restore, a message informing the same appears. A Completed status is 
reflected in the Status field. 

Important 

Do not interrupt the restore process in between. 

On successful completion of the restore procedure, the restored databases (Public Folder 
store/Mailbox stores) are displayed in the MS Exchange System Manager. 
 
 

 
http://www.ibackup.com/ibackup-professional/online-backup-exchange-server-backup.htm

If you encounter any problem, contact the IBackup support team at support@ibackup.com
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Exchange Brick-Level Mailbox Backup  

IBackup Professional is a secure, easy and reliable way to backup individual mailboxes on the MS 
Exchange Server Store to your IBackup Professional account through the ' Exchange Brick-Level 
Mailbox Backup’ option. The application backs up the contents of the selected mailbox or 
mailboxes to a Personal Folder file (.PST) that can be accessed using Microsoft Outlook at any 
point in time. 

This is not a method for complete backup (or recovery) of the Exchange Server databases. 

Ensure that appropriate mailbox rights are granted to perform the Exchange Brick-Level Mailbox 
Backup of selected mailbox/mailboxes. 

Backing up MS Exchange Server Mailboxes 

To backup the MS Exchange Server Mailboxes to your IBackup Professional account, follow the 
steps given below: 

1. To access the Exchange Brick-Level Mailbox Backup, click the Backup-Restore menu > 
Exchange Server > Exchange Brick-Level Mailbox > select Backup. 

 

2. Select the individual mailbox or mailboxes that you wish to backup to your IBackup 
Professional account from the MS Exchange Server. 

3. Browse to select a temporary location on your local computer where the selected MS 
Exchange Server mailboxes are to be stored as a Personal Folder file (.PST). 
 
Browse to select a temporary location on your local computer where the selected MS 
Exchange Server mailboxes are to be stored as a Personal Folder file (.PST). 
 

Note 

Ensure that the selected temporary location has sufficient free space to hold the contents 
of individual mailboxes of MS Exchange Server. 

You cannot select the temporary location if you are performing the MS Exchange Server 
Mailbox backup from a remote location.  
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4. While selecting mailbox/mailboxes for backup, you can customize your selection based on 
the following criteria. 

Backup all the messages: This option is enabled by default. If you leave it selected, all 
the contents of the mailbox are backed up. 
 
Based on Date: You can select messages of a specified date and time or those that fall 
between a particular date and time. 
 
Based on subject and attachment: You can select messages based on the subject or 
attachment. 

Select individual mailbox folders: Click this button to choose mailbox folders such as 
Inbox, Sent Items, Deleted Items, Calendars, Tasks, Journals etc, that you wish to 
backup. Only the selected folders are processed. 

5. Click the Backup Now button to perform an immediate backup. 

Or  

Click the Next button to schedule the backup for a future date and time. 

6. On completion of the backup job, a message appears displaying the same. 
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Exchange Brick-Level Mailbox Restore 

IBackup Professional is an easy, secure and reliable way to restore individual emails/messages 
from a Personal Folder (.PST) file to the MS Exchange Server Store through the Exchange Brick-
Level Mailbox Restore option. 

With this, you can restore the individual emails/messages from a Personal Folder (.PST) file to the 
selected Exchange Server Mailbox. 

Ensure that appropriate mailbox rights have been granted to perform the Exchange Brick-Level 
Mailbox Backup of selected mailbox/mailboxes. 

This is not a method for complete recovery of the Exchange Server databases. For this, use the 
Exchange Server Restore feature. 

Restoring MS Exchange Server Mailboxes 

To restore individual emails/messages from your Personal Folder (.PST) file to your Exchange 
Server Mailbox store, follow the steps below: 

1. To access the Exchange Brick-Level Mailbox Restore, click the Backup-Restore menu > 
Exchange Server > Exchange Brick-Level Mailbox > select Restore. 

 

2. Click the Browse button and select the Personal Folder (.PST) file that you wish to restore 
to your Exchange Server Mailbox. 

3. Select the Exchange Server Mailbox where you wish to restore the emails/messages from 
your Personal Folder (.PST) file. 
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4. Select any one from the following options to restore the emails/messages from your 
Persona Folder (.PST) file. 

o Restore all the messages 

This option is enabled by default. Leaving this option enabled will restore the 
whole Personal Folder (.PST) file contents to your Exchange Server store. 

o Based on Date 

This option allows you to select messages of a specified date and time or those 
that fall between a particular date and time. 
 

o Based on subject and attachment 

This option allows you to select emails/messages based on the subject or 
attachment. 

o Select individual mailbox folders 

This option allows you select folders such as Inbox, Sent Items, Deleted Items, 
Calendars, Tasks, Journals and so on, that you wish to restore. Here, only the 
selected folders are processed. 

5. From the list of import procedures, select one as per your requirement. 

o Copy data into Exchange store 

This option lets the application copy the email/message, which already exists, to 
the Exchange store. As a result, duplicate emails/messages are created in the 
Exchange store. 

o Merge data into the Exchange store 

This option lets the application check whether the copied email/message already 
exists in the Exchange store. If so, then the email/message would not be copied 
on restore. 

This option lets the application check whether the copied email/message already 
exists in the Exchange store. If so, then the email/message is not be copied on 
restore. 

o Replace existing data in Exchange store 

This option lets the application check whether the copied email/message already 
exists in the Exchange store. If so, the existing email/message is first deleted from 
the Exchange store and then copied. 

6. Click the Restore button to initiate the restore operation. To view the log details of the 
restore process, click the 'View Log' button that appears, once the restore operation is 
completed, irrespective of its success or failure. 

  Page 26 of 59 



 

Granting Mailbox Rights 

Microsoft Exchange 2000, Exchange Server 2003 and 2007 accounts with Enterprise 
Administrator rights are by default denied right to access all mailboxes. This means that Exchange 
Administrators do not have the privileges to open any mailbox found on any server within the 
Exchange organization. This restriction is also applicable if your login account is an Administrator 
account or if you are a member of the Domain Admin or the Enterprise Admin group. In these 
instances too, access to all mailboxes other than your own are denied, even if you have full 
administrative rights over the Exchange server system. 

However, Exchange 2000/2003/2007 administrative tasks can be performed without granting an 
administrator sufficient rights to read other people's email. These default restrictions can be 
removed with methods that are in total agreement with your organization's security and privacy 
policies. In most cases, applying these methods would be appropriate only in a recovery server 
environment. 

Granting rights to a specific mailbox 

Follow the steps given below to grant access to the Microsoft Exchange 2007 mailbox. 

Open the Exchange 2007 management shell and enter the following 

Syntax: Add-MailboxPermission - identity <mailbox name> -accessRights fullAccess - User 
administrator  

Example: To grant full access to the mailbox Adams > Add-MailboxPermission - identity Adams - 
accessRights fullAccess - User administrator  

Note 

To perform Exchange 2007 Brick-Level Backup, install the standalone version of MAPI from the 
Microsoft site. 

Download Standalone version of MAPI

Follow the steps given below to grant access to the Microsoft Exchange 2000 or Exchange 
2003 mailbox. 

To do so, you must have appropriate Exchange administrative permissions. 

1. Start Active Directory Users and Computers. 

2. On the View menu, ensure that the Advanced Features check box is selected. 

Note 

This is not necessary for Exchange Server 2003, as the 'Exchange Advanced' tab is 
exposed by default. 

3. Right-click the user whose mailbox you want to give permissions to and choose 
Properties. 

4. On the Exchange Advanced tab, click the Mailbox Rights. 
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Notice that the Domain Admins and Enterprise Admins have both been given Deny access 
to Full Mailbox access. 

5. Click the Add button and select the user or group that you wish to grant access to this 
mailbox and click the OK button. 

Make sure that the user or group is selected in the Name box. 

6. On the Permissions list, click Allow next to Full mailbox access, and then click the OK 
button. 

7. Click the OK button to finish. 
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Granting rights to mailboxes located within a specific mailbox store 

To grant access to (Exchange 2000 or Exchange 2003) mailboxes of a specific mailbox store, 
follow the steps given below: 

To do so, you must have appropriate Exchange administrative permissions. 

1. Start the Exchange System Manager > select the Servers folders. 

2. Click the plus mark to expand the Servers folder > select the required mailbox store 
present within the appropriate Storage Group. Right-click it and choose the Properties 
option. 

3. In the Properties window, open the Security tab.  

4. Click the Add button and select the user or group that you want to grant access to the 
mailboxes and then click the OK button. 

Make sure that the user or group is selected in the ‘Name’ box.  

5. In the Permissions list, click Allow for Full Control and then click the OK button. 

Note 

Ensure that the Deny checkbox is not selected for Send As and Receive As permission 
options. 

6. In the Mailbox Store Properties dialog, click the OK button to finish. 
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Granting rights to mailboxes located on a specific server  

To grant access to (Exchange 2000 or Exchange 2003) mailboxes found on a specific server, 
follow the steps given below: 

To do so, you must have appropriate Exchange administrative permissions. 

1. Start the Exchange System Manager> select the Servers folders. 

2. Click the plus mark to expand the Servers folder > select the appropriate Storage Group. 

3. Right-click and choose Properties. 

4. In the Properties window, open the Security tab and click the Add button. 

5. Select the user or group that you want to grant access to the mailboxes and click the OK 
button. 

Make sure that the user or group is selected in the Name box. 

6. In the Permissions for test mailbox section, click Allow for Full Control.   

Note 

Ensure that the Deny checkbox is not selected for Send As and Receive As permission 
options. 

7. Click the OK button to finish. 

Note 

It might take a while for changes to take effect. The number of domain controllers, Global 
Catalogs, site replication schedules and intervals would influence this. On a domain with 
one site containing multiple domain controllers, it might take up to 15 minutes before these 
new permissions become effective. On single servers, which are also DCs, the process 
will speed up on restarting the Information Store service. 
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System State Data Backup 

The IBackup Professional System State Backup wizard lets you perform backup of System State 
Data to your IBackup Professional account. 

The registry, the directory service and other key system components are contained in the System 
State Data. The `System State Data backup' feature lets you backup these components. 

On the standard Windows 2000/XP machine, System State Data backups contain the following 
items: 

• The Boot file 

• The COM+ Class Registration Database 

• The registry 

If the workstation is a Domain controller, then the System State Data backups contain the 
following items: 
 

• Active Directory (NTDS) 

• The system volume (SYSVOL) 

If the workstation is a certificate server, System State Data backups will also contain the data files. 

Follow these steps to backup System State Data to your IBackup Professional account: 

Step 1. Select the System State data Backup option 

Click the Backup-Restore menu > System State Data > select System State Data Backup. 

Step 2. Select Temporary Location 

Click the Browse button to select the temporary location on your local computer where the System 
State Data is to be stored. Ensure that the temporary location (directory/ folder) selected has 
about 1 GB of free space. 

Step 3. Schedule the Backup 

In the scheduler window, perform an immediate backup or schedule the backup for a future date 
and time. 

Note 

You must be an administrator or a backup operator to back up the system data components. 

System State Backup is not a replacement for a full disaster recovery solution that may include 
backup of entire system including creation of recovery disks. 
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Tools Menu 
The Preferences menu consists of two tabs: 

• General 

• Exclude Files and Folders 

General Tab 

• Backup When Idle 

• Automatic power off after scheduled backup 

• Prompt to view log files 

• Prompt for restore destination 

• Start the missed scheduled backup 

• Backupset Options 

• Bandwidth Throttle 

• Open file Backup 

 

Backup When Idle 

Selecting Backup When Idle option lets the application perform schedule backup of files when the 
computer is left in an idle state. If not, then the application automatically resets the bandwidth to 
25% and performs backup. 

Automatic Power off after Scheduled Backup 

Selecting Automatic Power Off After Scheduled Backup option lets the application automatically 
shut down your computer on completion of the scheduled backup. 
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Prompt to view log files 

Selecting Prompt to view log files option lest you view the log files on completion of backup/restore 
operation. 

Prompt for Restore Destination 

You can restore files and folders from your IBackup Professional account to your computer. There 
are three options available for selecting the destination directory for the restore operation. 

• Restore to the following directory 

This option restores the file/folder to the selected directory. 

• Restore to the same directory without overwriting the existing files 

This option restores the file/folder to the directory where it was restored earlier, 
but does not overwrite the existing file/folder. 

• Restore to the same directory overwriting the existing files 

This option restores the file/folder to the directory where it was restored earlier, 
but overwrites the file/folder with the new changes. 

For details, refer to Restore Files/Folders. 

Start the missed scheduled backup 

This option, if selected lets the application automatically start the scheduled backup when you 
restart the computer after 30 minutes of the scheduled time. By default, this option remains 
unselected. 

Backupset Options 

Backupset Options lets you view the required/selected backupset contents. For this, there are two 
options available: 

• Show all files backed up till a particular date/time 

• Show backed up files that existed on local computer at the date/time 

Bandwidth Throttle 

In the real-time business scenario, more often than not, you would be using more than one 
application (internet based) for your day-to-day activities. In such cases, bandwidth used by each 
application will effect the performance of the other. To overcome these hurdles, a provision for 
adjusting the bandwidth exists in the IBackup Professional application. This is an optional feature 
and it is up to you to decide the bandwidth usage. 
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Open File Backup 

You can backup open files using the Open file Backup feature available with IBackup Professional. 
This feature is available only for Windows XP, Windows 2003 servers and Windows Vista. 

The most common open files that can be backed up using this feature are Outlook files (.pst), 
QuickBooks, Quicken, ACT, MS-Money, MS-Word, MS-Excel, MS-Access, MS FoxPro etc.  
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Exclude Files and Folders Tab 

This option allows you to exclude files and folders from the backup jobs. You can exclude files and 
folders using any of the options below: 

• Exclude files/folders from backup based on full path name 

• Exclude files/folders from backup with partial name 

How to exclude files and folders 

Exclude folders based on full path name 

To add folders, follow the steps given below: 

1. Right-click in the section Folders with full path names. 

2. Select Add option (Add - to exclude folders from backup list) 

3. Select a folder from your local computer. 

4. Click the OK button to exclude the selected folder from the backup list/exclude list 
respectively. 

Exclude files based on full path name 

To add files, follow the steps given below: 

1. Right-click in the sections Files with full path names. 

2. Select the Add option (Add - to exclude files from backup list). 

3. Select a file from your local computer. 

4. Click the OK button to exclude the selected file from the backup list/exclude list 
respectively. The excluded files and folders are listed as shown below. 
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Exclude Files/Folders using right-click option 

You can also add files or folders to the exclude list using the right-click option in the IBackup 
Professional main window. You can exclude files or folders from both Backup and Restore tab. 

For this, follow the steps given below: 

1. Select a file or a folder on the IBackup Professional main window. 

2. Right-click and select the option Exclude this folder from being a part of the backup list 
from the shortcut menu. The selected folder or file will be excluded from the backup list. 

For files, select the option Exclude this file from being a part of the backup list. 

 

Exclude folder based on partial name 

You can also exclude folders using the Add option in the Exclude Files and Folders tab  window. 

In the Exclude file/folders based on partial name section, right-click the folders present in the 
section Folders with part/full name and select Add. 

An Enter Folder Name dialog appears as shown below. 

 

Here, enter the folder name. If full name of the folder is not known, use wildcard characters (*,?). 

Click the OK button > the folder is added in the IBackup Professional Exclude Files and Folders 
tab. 
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Exclude file based on partial name 

Similarly, to exclude files, use the right-click option in the section Files with part/full name of the 
Exclude Files and Folders tab. 

Click the Save button of the Exclude Files and Folders tab. This excludes the files/folders that start 
with the entered name followed by any/none/one character from backup. 

Note 

? - Replaces with a single character in a file name. 

* - Replaces with one/none/more character(s) in a file name 

To remove the files/folders from the Exclude Files and Folders tab, select the required folders/files 
and right-click the Remove button. The files and folders are removed from the IBackup 
Professional exclude directory. 

Including Excluded Files/Folders 

You can include folders to the backup job. This option is applicable only when a folder is excluded 
from backup. 

To include a folder, select a folder (folder not included in backupset) in IBackup Professional main 
window. Right-click and select Include this folder to part of the backup list option from the shortcut 
menu. 

Similarly, to include files, select a file (file not included in backupset) in IBackup Professional main 
window. Right-click and select Include this file to part of the backup list option from the shortcut 
menu. 
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Mapped Drives Backup 

To perform backup of Mapped Drives, follow the steps given below: 

1. Open the windows explorer. 

2. Right-click My Computer present on the left pane and select Map Network Drive option 
from the shortcut menu. 

3. Browse to select the network folder that you wish to connect to as a mapped drive. 

4. Click the Different user name option if you wish to connect to the computer using a 
different username. 

5. Click the Finish button. A mapped drive named (ex: 'Z') is created in My Computer. 

The same mapped drive is available in the IBackup Professional application. 

6. Select the files/folders to be backed up. 

7. Click the Tools menu and select Mapped Drive Setup. A Mapped Drive Setup dialog 
appears as shown below. 

 

8. Enter the appropriate username and password for the mapped drive and click the Save 
button to save the setting and schedule the job. 

Note 

The IBackup Professional application performs scheduled backup of mapped drives even 
when your computer is in logged off state. 
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Activity Log 
Activity Log menu consists of the following options: 

• Session 

• View complete logged history 

 

Session 

This lets you view the backup and restore operation details of a session. In the Session log dialog, 
the backup and restore operations are indicated by green and red colored arrow marks. You can 
also view the Session log from the IBackup Professional tray icon. 

View complete log history 

This lets you view the complete log history of backup, restore and delete operations performed in 
the IBackup Professional account till date. 
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Help 
Help menu consists of the following options: 

• Help Topics 

This lets you open the IBackup Professional help file. 

• Send Error Report 

This lets you contact the support team via email for any queries. 

• Quick Demo 

This lets you directly access and view the IBackup Professional product demo 
from the website. 

• Website 

This lets you directly access the IBackup Professional website. 

• About IBackup Professional 

This gives you information on the IBackup Professional version that you are 
currently using. 
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How to Backup Files and Folders 
You can perform backup operations in the Backup tab of the IBackup Professional application. 
The Backup tab displays files, folders and drives present on your computer. Here, you can select a 
singe file/folder/drive or multiple files/folders/drives that you wish to backup. 

You can backup files, folders and drives using two buttons: 

• Backup Now button 

• Schedule Backup button 

Backup Now 

This lets you perform immediate backup of selected files, folders and drives. 

Steps for Backup Now 

1. On the Backup tab, select a file/folder/drive from your local computer. 

The selected file/folder/drive is displayed in the Contents of my Backupset section of the 
IBackup Professional main window. 

2. Click the Backup Now button > the backup operation starts. 

A dialog displaying the backup process appears. In this dialog, you can adjust the 
percentage of Bandwidth used by the application. You can also stop/restart/cancel the 
backup operation using the Pause and Cancel buttons. The Resume button appears once 
you pause the backup process. 

3. On completion of backup, a message informing the same appears with Yes and No 
options. 

Click Yes to view the log file containing the details of backup, else click No. 

If you cancel the backup operation, then a message informing the same appears with Yes 
and No options. 

Using Right-Click Mouse Option 

You can also do this using the right-click mouse option. Select a file/folder/drive on the right pane 
of the Backup tab and right click. From the shortcut menu, select Backup this file/folder now ‘ 
option. You can also do this from IBackup Professional tray menu using the Backup Now option. 

Using Explorer 

You can also do this from the explorer. Select a file/folder and right-click. From the shortcut menu, 
select IBackup Professional > Backup Now. 
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Schedule Backup 

This lets you schedule backups for a future date and time as per your convenience. 

Select a file/folder/drive and click the Schedule Backup button. The IBackup Professional – 
Scheduler window appears. 

 

Note 

The IBackup Professional application performs scheduled backup of jobs even when your 
computer is in logged off state. This stands true even for scheduled backup of mapped drives. 
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Schedule Backup Options 

The Scheduler window displays different options for scheduling the backup, which are as given 
below. 

• Use Recommended Backup Time 

This option lets you schedule the backup of selected files/folders/drives at a 
particular time, set by the application. 

If you select this option, the backup will be faster as it is performed at off-peak 
hours. 

• Use Custom Backup Time 

This option lets you set the date, time and frequency, as per your convenience, for 
scheduled backup. 

• Start the Backup Immediately 

This option lets you perform immediate backup of files/folders/drives. This is akin 
to the Backup Now option. 

Along with date and time, you can set different frequencies for scheduled backups, the list of 
which are as displayed below. 
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Notification Options 

This option lets you receive notification after every scheduled backup operation. There are two 
options to select from: 

• Desktop Notification 

A notification is sent to your desktop on completion of the scheduled backup. 

• Email Notification 

An email notification on the status of the scheduled backup is sent to you, based 
on the options selected for email notification.. 

Options for Email Notification 

• Notify always 

• Notify on failure 

• Do not notify 

Send log extract and Mail to options is enabled if Notify on failure or Notify always is selected. 

Adding Email Address 

Enter the email address in the text box and click the Add button. The email address gets added. 
You can send email notification to multiple users by adding the email addresses of different users. 

Other Options 

Selecting the check box provided for Backup When Idle option lets the application perform 
automatic backup of files when the local computer is left in idle state. 

Selecting the check box provided for Start the Missed Scheduled Backup when the computer is 
turned on option lets the application automatically start the scheduled backup when the user 
restarts the computer after 30 minutes of the scheduled time. By default, this option is not 
selected. 

Click the OK button to schedule the backup for a future date and time. 
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Viewing Properties 
To view properties of a folder/drive, right-click the folder/dive and select Properties option from 
shortcut menu. You can do this on both the right and left pane of IBackup Professional window. 

Open file Backup 
This lets you to perform backup of open files – like Outlook files (.pst), QuickBooks, Quicken, ACT, 
MS-Money, MS-Word, MS-Excel, MS-Access, MS FoxPro and so on. The feature is available only 
for Windows Vista, Windows XP and Windows 2003 server. 

To perform backup of open files, follow the steps given below: 

1. Login to your IBackup Professional account, open the Preferences window from the Tools 
menu and select the option Enable open file backup. 

2. Using the Browse button, select a temporary folder where the backed up open files will be 
stored. 

3. In the Backup tab of the IBackup Professional window, select the opened file that you wish 
to backup. 

4. Click the Backup Now button if you wish to backup immediately. Else, click the Schedule 
Backup button to schedule the backup for a future date and time. 

Note 

Ensure that the selected temporary folder on the local computer has sufficient free space to 
hold the open files. You cannot select the temporary location if you are performing Open File 
Backup from a remote location. 

Do not use this feature to perform open file backup of MS SQL Server related files, as IBackup 
Professional application provides a separate feature for the same. 
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Restore Files/Folders 
You can restore files and folders from the IBackup Professional account to your local computer. 
The restore operation can only be done in the Restore tab. 

Steps for Restore 

1. In the Restore tab, select the files/folders/drives that you wish to restore to your local 
computer. 

2. Click the Restore Now button. A dialog for selecting the destination directory for restore 
appears. 

 

3. Select the destination directory using any one of the following options. 

• Restore to the following directory 

This is the default option. It allows you to browse and select the destination 
directory of your choice. 

• Restore to the same directory without overwriting the existing files 
(Recommended) 

This is a recommended option. In this option, files are restored to the same 
directory without overwriting the existing data. 

For example: If you restore a file from My IBackup Prof \ D:\test1.doc then the file 
is restored to D Drive (your local computer) under the name test1.1.doc. 
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• Restore to the same directory overwriting the existing file(s) (not recommended) 

This option lets the files to be restored to the same directory by overwriting the 
existing data. 

For example: If you restore a file from My IBackup Prof\D:\test1.doc then the file 
is restored to D Drive (your local computer) under the name test1.doc.  

This option is not recommended, as the data in the files will be overwritten, which 
cannot be retrieved. 

4. Click OK to begin the restore process. A dialog displaying the progress of restore appears. 

5. On completion of restore, a message informing the same appears with Yes and No 
options. Click Yes to view the log details. 

If you cancel the restore operation, then a message informing the same appears with Yes 
and No options. Click Yes to view the log details. 

  Page 47 of 59 



 

Search 
This option allows you to search files present in your IBackup Professional account. You can 
search files based on multiple conditions – like the file type (whether it is a doc file, txt file or a 
video file) and so on. You can use the wildcard options * and ? to locate files. Alternately, you can 
restore the searched files using the Restore button present in the File Search window, as shown 
below. 

Additionally, you can locate files present in a specific folder using the right-click Search option. 

 

Further, you can view different versions of the searched file. Select a file, right-click and select 
View History option. 

You can also do a quick search of file(s)/folder(s). For this, a text box and a Search button are 
provided at the right-hand corner, just below the tools menu, in both the Backup and Restore tab. 
Enter the file name or the first letter of the file in the text box and click the Search button > the 
IBackup Professional – File Search window appears displaying the search results. 
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Backupset Date/Time 
This option, in the Restore tab, lets you restore the backed up files and folders as of a particular 
Backupset. 

From Tools men, open the Preferences windows > select General tab > in the Backupset options, 
select one of the following. 

• Show all files backed up till a particular date/time 

• Show backed up files that existed on the local machine at the date/time 

In the Restore tab, click the drop-down arrow provided for Backupset date/time > from the drop-
down list, select the appropriate date and time. On the right pane of the Restore tab, the backed 
up files and folders are listed. 

Show all files backed up till a particular date or time 

This option allows you to view all files and folders backed up on your local computer, at a 
particular date and time. 

To view the files and folders, select the date and time from Backupset date/time drop-down list 
box, as shown below. 
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Show backed up files that existed on local machine at a particular 
date/time 

This option allows you to view the backed up files previously present on your computer at a 
particular date/time. 

To view the files and folders, select the date and time from Backupset date/time drop-down list 
box, as shown below. 
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Versioning feature in IBackup Professional 
In Small and Medium Businesses, maintaining history of each file with its update is necessary for 
future reference. The versioning feature of IBackup Professional application serves this need by 
generating different versions of a file after each update, thus maintaining the history of changes 
done to a specific file. 

For example: You have a file named Brick.jpg already backed up to your IBackup Professional 
account. You open this file, make changes and back it up at the same time. The IBackup 
Professional application performs incremental backup of this file and saves it, with the modified 
changes, as a different version. 

To view the version history of a file, select a file > right-click > select View history. 

 

Note 

Incremental backup will backup only the modified portions of a file. 

In your IBackup Professional account, the original file is available under the same name keeping 
both versions intact, that is version 1(the first full backup of that file) and version 2(the 1st 
incremental backup of the same file). 

You can restore the latest version of files from IBackup Professional account to your local 
Computer. For details, refer to Restore Files/Folders. 
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Delete Files/Folders 
Follow the steps given below to delete files and folders from your IBackup Professional account: 

1. Click the Restore tab and in the right/left pane, select the files/folders that you would like 
to delete and click the toolbar button Delete. 

2. A dialog box listing the files present in the selected folder/folders appears. Click the Delete 
button to remove the listed file/files from your IBackup Professional account. 

Sync 
This option is useful to sync data on your local machine with that in the IBackup Professional 
account. 

To Sync, follow the steps given below: 

1. Open the Backup/Restore tab and select a folder from IBackup Professional account (My 
IBackup Prof). 

2. Click the toolbar button Sync, a message explaining what the Sync operation does 
appears with Continue and Cancel buttons. Click the Continue button to proceed. 

If the selected folder on the IBackup Professional account (My IBackup Prof) is already in 
sync with the content on your computer, then a message asking you to select a relevant 
folder appears with OK button. Click the OK button and try again to select a relevant 
folder. 

  Page 52 of 59 



 

3. Click the Continue button, a Sync window appears as shown below. Here, files present in 
your IBackup Professional account but not on your computer (My Computer) are listed. 

 

4. Click the Sync button, a message appears informing you that the listed files will be deleted 
permanently. Click Yes to proceed with the Sync process. 

Remember, Sync option deletes the selected folder permanently from your IBackup 
Professional account to bring it in sync with the contents on your computer. 

5. On completion of the Sync process, a message asking if you would like to perform backup 
of the current content of your computer appears. Click the Yes button, the current contents 
of the selected folder on your computer are backed up to your IBackup Professional 
account. 

Note 

Sync option is enabled if you set Show all files backed up till a particular date/ time as the 
Backupset restore option in the General tab of the Preferences window. 

Use this feature carefully, only after you have completely understood how the sync feature works. 
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Settings 
In IBackup Professional application, you have the option to set the proxy settings. 

1. Click the Advanced button in the IBackup Professional login window. A Settings dialog 
appears. 

 

2. Select the check box Enable HTTP / Socks Proxy and select the option buttons provided 
for HTTP Proxy or SOCKS Proxy. 

Note 

Before you set the proxy settings, verify the proxy settings in your zone with your System 
Administrator. 
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System Requirements 
Microsoft Windows NT/ 2000, Professional/ Me/ 98 SE/ XP Home/ Professional, Windows 2000 
Advanced Server and Windows 2003 Server. 

IBackup Professional is compatible with the new operating system Windows Vista. 

Other Requirements 

• 512 MB RAM 

• 10 MB free hard disk space for installation 

• 20MB or more for local caching 

• Internet Explorer 6.0 is highly recommended 

Note 

With respect to the version compatibility of IBackup Professional on Windows NT/2000/XP/2003 
Server, scheduled backup jobs run from a Windows NT service. This automatically logs in to your 
IBackup Professional account with the login parameters specified during the configuration stage. 
Perform the scheduled backup job and logout from your IBackup Professional account. 

Important 

IBackup Professional requires a high encryption pack to work properly. If you are running 
Windows 2000 with Service Pack 1, then install the high encryption pack from the link below: 

http://www.microsoft.com/windows2000/downloads/recommended/encryption/

Windows 98 SE users need to upgrade their Internet explorer to IE6  
 
Windows NT server users must ensure that they have the service pack 6 installed. Administrator 
privileges  are mandatory for installing the IBackup Professional application. 
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Troubleshooting 
The following are some simple troubleshooting tips, which could resolve minor problems while 
working with IBackup Professional application. 

• Windows 2000 users must have service pack 2 or higher installed on the machine for 
encryption on storage to work properly. 

• You must have proper privileges to register the files required during installation. 

• The latest service pack for Windows must be installed on the computer. 

• When the application hangs for a long time and no transfers occurs, logout of the 
application and then login again. 

For further assistance, mail to support@ibackup.com
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Support 
Support Office 

Pro Softnet Corporation. 

IBackup Professional Division, 26115, 
Mureau Road, Suite A, 
Calabasas, CA 91302.
 

Tech Support 

Call at the below-given numbers 

If calling from within US 

1-855-819-9948 (Monday - Friday, 6:00 AM to 6:00 PM PST 

If calling from outside US 

1-818-403-3629 

For more information visit https://www.ibackup.com/ibackup-professional/
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